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I. Introduction 

What is Kapelle Scales? 

Kapelle Scales is an application for working with scales and modes 
of all kinds. Unlike applications which may be limited to a few 
activities or just very basic scale types, Kapelle Scales is capable of 
handling an infinite variety of scales and modes. 

Currently Kapelle Scales supports not only major and the three 
forms of minor, but also the medieval church modes, pentatonic, 
hexatonic, and octatonic scales, both standard and synthetic. Any 
scale or mode (that does not require microtones) can be supported 
by the application and easily incorporated. 

Kapelle Scales Exercises 

Kapelle Scales does not “hard-wire” the exercises into the program. 
Instead, exercises are small text files. Each line in the file contains 
an instruction which the application uses to construct an exercise. 
For example, one line might specify how many individual scales 
should be created for a particular exercise. 

The Varieties of Scale-Related Exercises 

The number of activities that can be done to work with scales and 
modes is surprisingly large. Kapelle Scales identifies no less than 
12 separate activities, with some of those activities having a 
number of options. Instead of listing all of those activities, here is a 
rundown of the fundamental types of scale-related activities that 
the application supports. 

Writing 

Writing scales and modes is obviously fundamental to learning 
scales. Scales may be written with or without key signatures, 
ascending or descending, starting on and ending with any particular 
scale degree. The first note may be given, or the exercise may 
specify to start on a scale degree. 
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Hearing 

Hearing scales is also fundamental. Scales and modes may be 
required to be identified by both tonic and mode, or by mode only. 
Hearing scales is not limited to starting on the tonic pitch—the well-
trained ear recognizes scales starting from all degrees. 

Identifying 

Identifying scales consists of recognizing a scale at sight with or 
without a key signature, starting from any particular scale degree. 
This can also include identifying a scale when given a single degree 
of that scale and its mode. 

Key Signatures 

Key signatures may be added to a set of pitches to create a 
particular scale or mode. In addition, key signatures may also be 
created—that is, the sharps or flats required to create a particular 
scale or mode can be assembled, rather than the key signature’s 
being selected from a list. 

Correcting 

Error-correction is always a good way to learn to write scales or 
modes. Scales may be presented with one note incorrect, all the 
way through to every note incorrect. 

Playing 

Playing scales is excellent practice. Kapelle Scales supports playing 
scales from a particular scale degree, or starting from a given note. 

About the Tutorials 

These tutorial exercises do not cover every single activ ity offered 
by Kapelle Scales. The tutorials cover just those skills which you 
will need to use the program. 

For example, once you know how to notate a scale, then you also 
have the skills necessary to add accidentals to scales or error-
correct scales. Thus adding accidentals and error correction is 
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skipped in the tutorials. 

Also, the tutorial exercises are generally much shorter than “real” 
exercises you will do. 

Finally, don’t worry about the grade you get on a tutorial exercise. 
The idea here is to learn to use the program. 
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II. Tutorial 1: Basics 

Tutorial 1 covers the notational system in Kapelle Scales. As such it 
is the longest of the tutorials. 

If you are already familiar with other Kapelle-series programs that 
use notation (in particular, Kapelle Dictation) then you may skim 
this tutorial quickly. You will find that the notation system in 
Kapelle Scales is a subsystem of that used in Kapelle Dictation and 
will be very easy to understand. 

However, you should go through the tutorial briefly, just to note 
any differences that exist between the two applications. 

A Note About Exercise Length 

Most exercises consist of a number of scales that are presented to 
you. The exercise requires that you finish all of the presented 
scales before your grade is permanently recorded. 

However, for the purposes of these tutorials, most exercises will 
consist of one single scale, or just a few. 

Opening the Exercise 

All of the exercises available to you are located in a standard tree-
type control on the left side of the main window: 
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Figure 1: The Main Window 

This pane contains both folders and exercises. 

To expand a folder, click on the plus sign ( + ) to the left of the 
folder. It will expand to show its contents—which can be more 
folders as well as exercises. 

Open the Tutorials folder by clicking once on the plus sign: 

 
Figure 2: Opening the Tutorials Folder 

Then open the first exercise, 01 – Basics, by double-clicking on 
the exercise icon. 

In a moment, the exercise will be presented to you. 

Since this is a tutorial exercise, it has been limited to one single 
ascending A-Major scale to write. 

Before starting to work on the scale, take a look at the parts of the 
screen before you. 

Tree Control 
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Parts of the Screen 

 
Figure 3: Parts of the Screen 

Announcements Pane 

The Announcements Pane contains the instructions for you to follow 
for this particular exercise. Always read it carefully: it will tell you 
what kind of scale to write, whether the scale is ascending or 
descending, and what to do after you’ve written the scale. 

Notation Pane 

The Notation Pane is the onscreen area in which you actually notate 
the exercise. There is a color bar on the bottom of the Notation 
Pane which might act as a double-clickable button in some cases, 
or will serve to identify the scale for you in others. 

Comment Pane 

Every exercise contains a comment of some sort. This comment 
was written by the author of the exercise and contains extra 
information about the exercise. 

Notating the Scale 

Moving the Cursor 

The cursor is a rectangular blinking black object: 

Announcements Pane 

Notation Pane 

Comment Pane 



Kapelle Scales Tutorials 
Page 9 

 
Figure 4: The Cursor 

The cursor may be moved vertically or horizontally. (Horizontal 
motion is only possible when there are multiple notes within a 
measure.) 

To move the cursor vertically, press the up arrow or the down 
arrow keys. 

To move the cursor horizontally, press the right arrow or left 
arrow keys. (Note that the cursor will not move horizontally until 
you have inserted some notes.) 

Entering Notes 

Since we are going to notate an A-Major scale, move the cursor so 
that it is positioned directly over the second space of the clef: 

 
Figure 5: The Cursor Positioned Over ‘A’ 

To enter a note at this location, press the Enter key. The note is 
entered: 

 
Figure 6: Note Entered 

Alternate Techniques to Enter Notes 

If you prefer to enter a note with the mouse, you may do any of 
the following: 

• Select Enter Note from the Note Menu: 
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Figure 7: Enter Note from the Note menu 

• Click the Enter Note icon  on the Toolbar. 

• Right-click on the cursor, then select Enter Note from 
the context menu: 

 
Figure 8: Using the Context Menu 

Editing Notes 

Deleting Notes 

To delete a note, make sure that the cursor is positioned directly 
over the note head, then press Backspace. 

Moving Notes 

To move a note, make sure that the cursor is positioned directly 
over the note head, then press Ctrl+Up Arrow to move the note 
upwards, or Ctrl+Down Arrow to move the note downwards. 

Adding Accidentals  

To add a sharp or flat to a note, make sure that the cursor is 
positioned directly over the note head, then press F7 to flat the 
note or F8 to sharp the note. 

Editing Notes Using the Mouse 

The techniques outlined above for note editing all use the 
keyboard, which is the quickest way to handle these actions. 
However, you may also use the mouse to edit or enter notes. The 
section on entering notes illustrated alternate techniques. Those 
same basic techniques exist for all other note-editing commands as 
well. 
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Using the Menu Bar 

The Notes Menu contains all commands for editing notes. Make 
sure that the cursor is positioned over the note head you wish to 
edit, then select a command from the Notes Menu: 

 
Figure 9: The Notes Menu 

Using the Toolbar 

The left-most portion of the Toolbar contains note-editing 
commands: 

 
Figure 10: Note-Editing Toolbar Commands 

TIP: if you’re not sure what the icon means, hold the mouse over 
the icon for 1 second and a little window will pop up telling you 
what it does. 

Using Context Menus 

You may also right-click at the cursor’s location, and a context 
menu will pop up containing only those commands which are 
pertinent to the current situation: 

 
Figure 11: A Context Menu for Note Editing 

Undo and Redo (“Taking Back”) Actions 

You may undo, or take back, any editing action up to the time you 
began to work on this scale. 

To Undo a single action, select Undo from the Edit Menu. (The 
name of the Undo command will reflect the action—such as Undo 
Add Note.) 
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To Undo multiple actions, select Undo Multiple from the Edit 
Menu. You may select any actions you wish to undo from the dialog 
box that comes up. 

To Redo actions (that is, to “take back” the Undo), use the Redo 
and Redo Multiple commands on the Edit Menu. 

Making Multiple Selections 

You are not limited to editing one note at a time. You may select a 
group of notes  for editing as follows: 

• Press down and hold the left mouse button 

• Drag the mouse from top-left to bottom-right of the 
notes you wish to edit: make sure that their 
noteheads are included in the area. 

• Release the mouse button. The area you have selected 
will be highlighted in inverse video: 

 
Figure 12: Multiple Selection 

Finishing the Notation 

Go ahead and notate the A-Major ascending scale using the 
techniques outlined above: add notes, delete them if you want, 
move them around, add and remove accidentals. 

When you’re finished, this is how it should look: 

 
Figure 13: A Completed Scale 

Signifying Your Answer is Ready 

When you are sure you have completed the scale, give the Answer 
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Ready command by pressing F5.  

Of course you may give the Answer Ready command with the 
mouse as well: 

• Select Answer Ready from the Scale Menu. 

• Right-click and choose Answer Ready from the 
Context menu. 

• Click the Answer Ready icon  on the Toolbar. 

Once you tell Kapelle Scales that your answer is ready, it will 
evaluate your work. The screen will change to look like this: 

 
Figure 14
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III. Tutorial 2: Identifying Scales 

You’re going to be listening to scales in this tutorial, so be sure to 
turn on your computer’s speakers or put on your headphones. 

Opening the Exercise 

Open the exercise Tutorial 02 – Identifying Scales from the tree 
control on the left of the main window. 

In addition to double-clicking on the exercise to open it, you may 
also: 

• Left-click once to select it, then right-click and select 
Open Exercise from the Context Menu. 

• Left-click once to select it, then select Open Exercise 
from the File Menu. 

TIP: you can resize the horizontal of the tree pane by dragging on 
the split bar between it and the main window: 

 
Figure 15: Resizing the Tree Pane 

Playing the Scale 

The scale was played for you as soon as it was presented. You may 
play it as many times as you like. 

To play the scale again: 

• Press the Spacebar. 

• OR: select Play Scale from the Playback Menu. 
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• OR: right-click in the notation pane and select Play 
Scale from the Context Menu. 

To stop playback early: 

• Press the Spacebar. 

• OR: select Stop Playback from the Playback Menu. 

• OR: right-click in the notation pane and select Stop 
Playback from the Context Menu. 

Identifying the Scale 

You will note that the bar underneath the notation pane has 
acquired some text: 

 

 
Figure 17: Announcement Pane’s Instruction 

Also, check on the Scale Menu, and you’ll see yet another way to 
carry this out: 

 
Figure 18: Identify Scale From the Scale Menu 

In short, there are lots of ways to get the same thing done. 

By whatever method you choose, give the command. You’ll be 
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presented with the Identify Scale dialog box: 

 
Figure 19: Identify Scale Dialog Box 

Select the tonic and mode for the
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Figure 21: After the Scale is Identified 
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Figure 22: Progress Report Dialog Box 

Note that the two tutorial exercises you have done are already 
listed in this window. 

Printing Your Progress Report 

For this tutorial, try printing your progress report. Click on the 
Print… button. In a moment, your progress report will be printed. 
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IV. Tutorial 3: Identifying the Mode 

In this tutorial, you will identify the mode of several scales. There is 
no notation involved in this tutorial. 

Opening the Exercise 

Open the Tutorial exercise Tutorial 03 – Identifying the Mode.  

As soon as you open the exercise, the first scale will be played. 
Notice that you won’t see any notation onscreen this time—in this 
kind of exercise, you identify only the mode, and not the tonic. 

You may play the scale as many times as you wish. See the 
previous tutorial for information about playing scales. 

Identifying the Mode 

Note that you may double-click on the color bar immediately below 
the Notation Pane (which in this style is the only thing showing) to 
identify the mode. 

Note also that the Announcements Pane offers another way to do it 
(press Ctrl+D). 

Note that you can also select Identify Mode… from the Scale 
Menu. 

Go ahead and give the command to identify the mode, using any of 
the proferred techniques. You are presented with the Identify Mode 
Dialog Box: 

 
Figure 23: Identify Mode Dialog Box 
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You may select the correct mode for this scale from the list of 
choices. 

TIP: type the first letter of the mode’s name to select it more 
quickly. Repeated typing of the letter will result in the selection of 
any mode name beginning with that letter. 

Click OK (or press Enter) when you’ve selected the mode. 

Signifying Your Answer is Ready 

Signify your answer is ready by pressing F5 or using any of the 
other techniques for accessing the Answer Ready command 
(outlined in earlier tutorials.) 

The window will change to look like this: 

 
Figure 24: After Identifying the Mode 

Note that this illustrates an incorrect answer! 

Up to this point in the tutorials you’ve been finished at this point. 
But this exercise contains more than one scale! You have to answer 
them all before you have finished the exercise. 

Obtaining Another Scale 

To obtain another scale, select New Scale. This command can be 
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accessed by any of the following techniques: 

• Press Ctrl+N. 

• Select New Scale
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Filtering Your Progress Report By Date 

The topmost property sheets is the Dates property sheet. You may 
select to restrict the displayed items to those appearing within the 
past day or multiple of days, week or multiple of weeks, or month 
or multiple of months. 

Filtering Your Progress Report By Exercise 

 
Figure 27: Filter by Exercise Property Sheet 

You may select individual exercises for inclusion or exclusion. Click 
on the check to the left of the exercise’s name to select it. You may 
select all (or clear all) of the check marks by using the buttons for 
that purpose. 

Filtering Your Progress Report By Grade 

 
Figure 28: Filter by Grade Property Sheet 

You may display only those exercises which have final grades 
between a range of values, from 0 to 100. 
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V. Tutorial 4: Identifying the Tonic 

In this tutorial, you will be shown a single scale degree, given the 
mode, and asked to identify the tonic. 

Opening the Exercise 

Open the exercise Tutorial 04 – Identifying the Tonic. You will 
be shown something similar to this: 
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Figure 30: Identify Tonic Dialog Box 

Select the tonic note from the drop-down list box. As with other list 
boxes, you may type in the letter of the tonic to select it: repeated 
typings of the same letter will select those tonic pitches beginning 
with that letter. 

For example, repeatedly typing ‘g’ will result in the selection of Gb, 
 /wo(, ) T36.5 0  TD /F6 11.25  Tf
-063837  Tc 0  Tw #Gb
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name, the score you received, or the time/date the exercise was 
done. 

To sort the entries, click on the column header: 
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VI. Tutorial 5: Creating a Key Signature 

In this exercise, you will create a key signature. 

Opening the Exercise 

Open the exercise Tutorial 05 – Creating a Key Signature. It 
will open showing you a scale without a key signature or 
accidentals, but will identify the tonic and mode: 

 
Figure 34: Creating Key Signatures Exercise 

In the above illustration, the given note is the first degree—Db—of 
a major scale. Therefore we may conclude that the scale is to be 
Db Major. 

Opening the Create Key Signature Dialog 

To open the Create Key Signature Dialog, use any of the following 
techniques: 

• Double-click on the color bar below the Notation Pane 

• Press Ctrl+E 

• Select Create Key Signature… from the Scale Menu. 
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• Right-click on the Notation Pane and select Create 
Key Signature from the Context Menu. 

Using the Create Key Signature Dialog 

 
Figure 35: Create Key Signature Dialog Box 
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Selecting Accidentals 

If you want to select an accidental (to be deleted or nudged), then 
click directly on it. The accidental will change to red: 

 
Figure 38: Selected Accidental 

In the above illustration, the E-flat is selected (black-and-white 
printing may not show this). 

You may select all accidentals by clicking on the Select All button, 
and clear all selections by clicking on Clear All. 

Moving Accidentals 

If you don’t aim just right, you might need to move the accidental. 
That’s easy: just keep clicking vertically until the accidental jumps 
to the location you want it to be. 

You can also nudge an accidental up or down one line or space by 
selecting the accidental(s) you wish to move, and then using the 
Nudge Up and Nudge Down buttons. 

Deleting Accidentals 

To delete an accidental, select it and then click on the Delete 
button. 

To delete all of the accidentals, click on the Delete All button. 

Closing the Create Key Signature Dialog 

To close the Create Key Signature Dialog, click the OK button. 

If You Aren’t Allowed to Close the Dialog 

If the key signature you created is not a valid key signature, you 
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will not be allowed to close the dialog box: 

 
Figure 39: Invalid Key Signature Message 

This can be caused by a number of factors: 

A gap in your key signature 

If you left a ‘hole’ or gap between two columns, you have an invalid 
key signature. Here’s an example of one such signature: 

 
 Figure 40 Tj
-2  0 TD /0.0297 Tfc -0.0297 Tf ( : Key Signature)With Gap Tj
-2 5.25 0 TD /0 Tfc . Tf ( ) Tj
-1275.25 -30 TD /F78 9 Tf
-0.1866 Tfc -0.086 Tf ( Accidentals positioned on improper lines or spaces Tj
-212.25 0 TD /0 Tfc -0.252 Tf ( ) Tj
-1212.25 -2475  TD
/F72 11.25 Tf
-0.18171 Tfc -0.092f Tf ( If you have) Tj
-6675  0 TD /0.18246 Tfc -0.0104 Tf ( an accidental which is not positioned on the correct line) Tj
-16675  13.5  TD /0.18135 Tfc -0.0388 Tf ( or space, you have)an invalid key signature. Here)is an example of
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Figure 42: After Creating a Key Signature 

This exercise contains multiple scales, so go ahead and practice a 
bit more. 
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VII. Tutorial 6: Playing Scales 

In this final tutorial you will learn how to use Kapelle Scales for 
playing scales. 

Because scale-playing exercise presuppose that the notation will 
not be visible as you play, Kapelle Scales 
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• A red-colored box means that it is the currently-
selected scale degree: any note you play will be 
recorded as this scale degree. 

• A gray-colored box means that this particular scale 
degree has not yet been played. 

• A white-colored box means that this particular scale 
degree has been played, but is not the selected scale. 

Selecting a Scale Degree 

If you prefer to select a scale degree manually, simply click on it 
and it will become selected. 

Playing Your Scale 

To play the scale, play the notes one by one on your attacked MIDI 
keyboard. The selected scale degree will jump ahead automatically 
after you have played the degree. 

You may check your performance (once you have played all of the 
notes at least once) by clicking on the Play My Input button. You 
may stop playback by clicking on the Stop Play button. 

Closing the Play Scale Dialog 

Close the Play Scale dialog by clicking the OK button, or pressing 
Enter. 

In addition to closing the dialog, it will also give the Answer 
Ready command for you automatically. The screen will change to 
allow you to see your performed scale as well as the “correct” 
scale: 
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Figure 44: After Playing the Scale 

If the Octave is Different Than Your Performed 
Scale 

You might find that you played the scale an octave or two lower or 
higher than the scale you actually see notated in the Notation Pane. 
This is normal behavior for the application: it adjusts the scale you 
played to be as close as possible to the “source” scale (the one that 
you’re supposed to play), in order to ensure that the notated scale 
will stay within the confines of the Notation Pane and will not be 
written with an excessive amount of leger lines, either up or down. 


